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Guarantee 

This equipment is guaranteed against defects in materials and workmanship. 

We will repair or replace products which prove to be defective during the 

guarantee period as detailed on your invoice, provided they are returned to us 

prepaid. The guarantee will not apply to: 

 Equipment which has been modified or altered in any way without the

written permission of Campbell Scientific

 Batteries

 Any product which has been subjected to misuse, neglect, acts of God or

damage in transit.

Campbell Scientific will return guaranteed equipment by surface carrier 

prepaid. Campbell Scientific will not reimburse the claimant for costs incurred 

in removing and/or reinstalling equipment. This guarantee and the Company’s 

obligation thereunder is in lieu of all other guarantees, expressed or implied, 

including those of suitability and fitness for a particular purpose. Campbell 

Scientific is not liable for consequential damage. 

Please inform us before returning equipment and obtain a Repair Reference 

Number whether the repair is under guarantee or not. Please state the faults as 

clearly as possible, and if the product is out of the guarantee period it should 

be accompanied by a purchase order.  Quotations for repairs can be given on 

request. It is the policy of Campbell Scientific to protect the health of its 

employees and provide a safe working environment, in support of this policy a 

“Declaration of Hazardous Material and Decontamination” form will be 

issued for completion. 

When returning equipment, the Repair Reference Number must be clearly 

marked on the outside of the package. Complete the “Declaration of 

Hazardous Material and Decontamination” form and ensure a completed copy 

is returned with your goods. Please note your Repair may not be processed if 

you do not include a copy of this form and Campbell Scientific Ltd reserves 

the right to return goods at the customers’ expense. 

Note that goods sent air freight are subject to Customs clearance fees which 

Campbell Scientific will charge to customers. In many cases, these charges are 

greater than the cost of the repair. 

Campbell Scientific Ltd, 

80 Hathern Road,  

Shepshed, Loughborough, LE12 9GX, UK 

Tel: +44 (0) 1509 601141 

Fax: +44 (0) 1509 270924
Email: support@campbellsci.co.uk 

www.campbellsci.co.uk 

https://www.campbellsci.com/




PLEASE READ FIRST 

About this manual 

Please note that this manual was originally produced by Campbell Scientific Inc. primarily for the North 

American  market. Some spellings, weights and measures may reflect this origin. 

Some useful conversion factors: 

Area:   1 in
2
 (square inch) = 645 mm

2
 

Length:    1 in. (inch) = 25.4 mm 

1 ft (foot) = 304.8 mm 

1 yard = 0.914 m 

1 mile = 1.609 km 

Mass:  1 oz. (ounce) = 28.35 g 

1 lb (pound weight) = 0.454 kg 

Pressure: 1 psi (lb/in
2
) = 68.95 mb 

Volume: 1 UK pint = 568.3 ml 

1 UK gallon = 4.546 litres 

1 US gallon = 3.785 litres 

In addition, while most of the information in the manual is correct for all countries, certain information 

is specific to the North American market and so may not be applicable to European users.  

Differences include the U.S standard external power supply details where some information (for 

example the AC transformer input voltage) will not be applicable for British/European use. Please note, 

however, that when a power supply adapter is ordered it will be suitable for use in your country. 

Reference to some radio transmitters, digital cell phones and aerials may also not be applicable 

according to your locality. 

Some brackets, shields and enclosure options, including wiring, are not sold as standard items in the 

European market; in some cases alternatives are offered. Details of the alternatives will be covered in 

separate manuals. 

Part numbers prefixed with a “#” symbol are special order parts for use with non-EU variants or for 

special installations. Please quote the full part number with the # when ordering. 

Recycling information 

At the end of this product’s life it should not be put in commercial or domestic refuse but 

sent for recycling.  Any batteries contained within the product or used during the 

products life should be removed from the product and also be sent to an appropriate 

recycling facility. 

Campbell Scientific Ltd can advise on the recycling of the equipment and in some cases 

arrange collection and the correct disposal of it, although charges may apply for some 

items or territories.  

For further advice or support, please contact Campbell Scientific Ltd, or your local agent. 

Campbell Scientific Ltd, 80 Hathern Road, Shepshed, Loughborough, LE12 9GX, 

UK Tel: +44 (0) 1509 601141    Fax: +44 (0) 1509 270924  

Email: support@campbellsci.co.uk 

www.campbellsci.co.uk 

https://www.campbellsci.com/
https://www.campbellsci.com/repair
mailto:repair@campbellsci.com




Safety 
DANGER — MANY HAZARDS ARE ASSOCIATED WITH INSTALLING, USING, MAINTAINING, AND WORKING ON 
OR AROUND TRIPODS, TOWERS, AND ANY ATTACHMENTS TO TRIPODS AND TOWERS SUCH AS SENSORS, 
CROSSARMS, ENCLOSURES, ANTENNAS, ETC.  FAILURE TO PROPERLY AND COMPLETELY ASSEMBLE, 
INSTALL, OPERATE, USE, AND MAINTAIN TRIPODS, TOWERS, AND ATTACHMENTS, AND FAILURE TO HEED 
WARNINGS, INCREASES THE RISK OF DEATH, ACCIDENT, SERIOUS INJURY, PROPERTY DAMAGE, AND 
PRODUCT FAILURE.  TAKE ALL REASONABLE PRECAUTIONS TO AVOID THESE HAZARDS.  CHECK WITH YOUR 
ORGANIZATION'S SAFETY COORDINATOR (OR POLICY) FOR PROCEDURES AND REQUIRED PROTECTIVE 
EQUIPMENT PRIOR TO PERFORMING ANY WORK. 

Use tripods, towers, and attachments to tripods and towers only for purposes for which they are designed.  Do not 
exceed design limits.  Be familiar and comply with all instructions provided in product manuals.  Manuals are 
available at www.campbellsci.eu or by telephoning +44(0) 1509 828 888 (UK).  You are responsible for conformance 
with governing codes and regulations, including safety regulations, and the integrity and location of structures or land 
to which towers, tripods, and any attachments are attached.  Installation sites should be evaluated and approved by a 
qualified engineer.  If questions or concerns arise regarding installation, use, or maintenance of tripods, towers, 
attachments, or electrical connections, consult with a licensed and qualified engineer or electrician. 

General 
• Prior to performing site or installation work, obtain required approvals and permits. Comply with all

governing structure-height regulations, such as those of the FAA in the USA.
• Use only qualified personnel for installation, use, and maintenance of tripods and towers, and any

attachments to tripods and towers.  The use of licensed and qualified contractors is highly recommended.
• Read all applicable instructions carefully and understand procedures thoroughly before beginning work.
• Wear a hardhat and eye protection, and take other appropriate safety precautions while working on or

around tripods and towers.
• Do not climb tripods or towers at any time, and prohibit climbing by other persons. Take reasonable

precautions to secure tripod and tower sites from trespassers.
• Use only manufacturer recommended parts, materials, and tools.

Utility and Electrical 
• You can be killed or sustain serious bodily injury if the tripod, tower, or attachments you are installing,

constructing, using, or maintaining, or a tool, stake, or anchor, come in contact with overhead or
underground utility lines.

• Maintain a distance of at least one-and-one-half times structure height, or 20 feet, or the distance
required by applicable law, whichever is greater, between overhead utility lines and the structure (tripod,
tower, attachments, or tools).

• Prior to performing site or installation work, inform all utility companies and have all underground utilities
marked.

• Comply with all electrical codes.  Electrical equipment and related grounding devices should be installed
by a licensed and qualified electrician.

Elevated Work and Weather 
• Exercise extreme caution when performing elevated work.
• Use appropriate equipment and safety practices.
• During installation and maintenance, keep tower and tripod sites clear of un-trained or non-essential

personnel.  Take precautions to prevent elevated tools and objects from dropping.
• Do not perform any work in inclement weather, including wind, rain, snow, lightning, etc.

Maintenance 
• Periodically (at least yearly) check for wear and damage, including corrosion, stress cracks, frayed cables,

loose cable clamps, cable tightness, etc. and take necessary corrective actions.
• Periodically (at least yearly) check electrical ground connections.

WHILE EVERY ATTEMPT IS MADE TO EMBODY THE HIGHEST DEGREE OF SAFETY IN ALL CAMPBELL 
SCIENTIFIC PRODUCTS, THE CUSTOMER ASSUMES ALL RISK FROM ANY INJURY RESULTING FROM IMPROPER 
INSTALLATION, USE, OR MAINTENANCE OF TRIPODS, TOWERS, OR ATTACHMENTS TO TRIPODS AND TOWERS 
SUCH AS SENSORS, CROSSARMS, ENCLOSURES, ANTENNAS, ETC. 
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1. Introduction
Designed around Campbell Scientific’s VSPECT™ measurement technology, the VWIRE 305
Dynamic Vibrating Wire VSPECT Analyzers measure vibrating wire sensors at rates up to 333.3 Hz
with high accuracy. You can use an analyzer without a data logger in a bench test, or one or
more analyzers with a Campbell Scientific data logger in a field installation.

This manual discusses the use of the VWIRE 305 with the following products, which are sold
separately:

l Wall Charger 12 VDC 800 mA Output, 100-240 VAC
l CPI Network Kit
l GRANITE data logger
l LoggerNet data logger support software

2. Precautions
l READ AND UNDERSTAND the Safety (p. iii) section at the front of this manual.

l WARNING:
o Protect from over-voltage
o Protect from water
o Protect from ESD (electrostatic discharge)

l IMPORTANT: Maintain a level of calibration appropriate to the application. Campbell
Scientific recommends factory recalibration of the VWIRE 305 every three years.

3. Initial inspection
l The VWIRE 305 ships with the following:

o GRANITE Parts Kit (1)

l Inspect the packaging and contents for damage immediately. File damage claims with the
shipping company.
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l Check packaging materials for all products. Check model numbers, part numbers, product
descriptions, and cable lengths against shipping documents. Model or part numbers are
found on each product. Cable numbers are normally found at the end of the cable that
connects to the measurement device. Check that expected cable lengths were received.
Contact Campbell Scientific immediately if you find any discrepancies.

l Check the operating system version in the VWIRE 305, and the data logger. Update as
needed. See Operating systems (p. 12).

4. Quickstart
This procedure will get the VWIRE 305 set up to make measurements before connecting it to a
GRANITE data logger. This procedure, makes real-time measurements of vibrating wire sensors. It
does not store data (storing data requires an attached data logger).

4.1 Equipment
l Vibrating wire sensor

l VWIRE 305 analyzer

l Power supply (Wall Charger 12VDC 800mA Output, 100-240VAC 50 60Hz, 6ft Cable is used
in this procedure)

l USB cable

l Computer

l DVW Toolbox software

VWIRE 305 2



The following figure shows a general schematic of connections:

FIGURE 4-1. General schematic

4.2 Procedure
1. Install DVW Toolbox software on the computer. The DVW Toolbox installation also installs
USB drivers for the VWIRE 305.

2. Connect the sensors to the VWIRE 305 (FIGURE 4-2 (p. 3) and FIGURE 4-3 (p. 4)). For
further guidance on connecting sensors, see Sensor connections (p. 30).

FIGURE 4-2. Three-wire sensor connection schematic (no embedded thermistor)
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FIGURE 4-3. Five-wire sensor connection schematic

3. Connect the power supply to the VWIRE 305 power connector as shown.

FIGURE 4-4. Opening the power connector terminals

4. Plug in the power supply. The VWIRE 305COMM Status light flashes yellow. Channel Status
lights may flash or remain dark.

5. Connect the USB cable between a standard computer USB port and the VWIRE 305USB
port.
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6. Open DVW Toolbox. A window similar to the following figure appears:

7. In the Com Port list, select CDM-VW300 (COMn).

The Com Port box displays CDM-VW300 (COMn). Your COMn number may differ from
that shown.

8. Connect

DVW Toolbox and the VWIRE 305 connect and the button at lower left will show
Disconnect. Device Type, Serial Number, Device Name, and CPI address at lower center are
active. Depending on the state in which the VWIRE 305 was last used, channels may or may
not be enabled.

9. Check the Enable box for channels to which sensors are connected. If the correct channels
are selected, a green Channel Status flash indicates the sensor attached to that channel is
working. Lights of disabled channels are dark. For other flash combinations, see Status of
input channels and sensors (p. 45).
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The main DVW Toolbox window will look similar to the following figure:

l If a sensor does not have a temperature sensing element, the value in the Static
Thermistor column will be negative (Channel 1).

l Reasonable values in the Dynamic Frequency and Static Frequency columns indicate
the sensor outputs a vibrating wire signal. Check the values against the manufacturer
provided documentation to see if sensor output is within the correct frequency
output range.

l The absence of warning and information icons indicates the VWIRE 305 detects no
measurement faults. If you see a warning or information icon, see DVW Toolbox
errors (p. 37).

10. For more information on adjusting Sample Rate, enabled channels, and Frequency
Boundaries see VWIRE 305 settings (p. 22), and VWIRE 305 outputs (p. 27).

5. Programming quickstart
using DVW Toolbox
Campbell Scientific DVW Toolbox is an easy way to generate a simple CRBasic program for your
Campbell Scientific data acquisition system.
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1. Configure the VWIRE 305 for measurements, see Quickstart (p. 2).

2. Select CRBasic Code then Save... and select the data logger you will be connecting the
VWIRE 305 to.

3. By default, the CRBasic program will be saved in C:\Campbellsci\DVWTool.

6. Overview
Vibrating wire sensors measure strain, load, tilt, inclination, temperature, pressure, extension, and
crack movement. Measurements are stable and accurate, and sensors often survive a long time in
harsh conditions. However, the conventional technology has two problems: sensors cannot be
measured rapidly and, over a long time, sensor signal strength may be diminished.

The dynamic VSPECT measurement technology used in the VWIRE 305 overcomes these
problems and yields measurements with superior precision and noise immunity.

Quickstart (p. 2) includes simplified procedures that give a good orientation of the equipment
and software. There are nuances to the VWIRE 305 that can nullify the validity of measurements,
so you should review this entire manual before collecting actionable data.

6.1 Input channels
The VWIRE 305 is an eight-channel module (FIGURE 6-1 (p. 8)). Each removable connector has
two channels, and each channel measures one vibrating wire sensor and one embedded
thermistor or RTD. All channels are measured simultaneously. Multiple modules can be
connected to the data logger using the CPI bus. Use the CPI calculator at
www.campbellsci.com/downloads/cpi-calculator to estimate the usage and capacity of a CPI
network. To avoid skipped scans and frame errors with a VWIRE 305 network, the CPI bus load
should not exceed 75%.
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FIGURE 6-1. VWIRE 305

6.2 Dynamic sample rates
The VWIRE 305 makes dynamic measurements at 20, 50, 100, 200, or 333.3 Hz depending on the
resonant frequency. See Table 9-1 (p. 22).

6.3 Static measurement
As part of the dynamic measurement, the VWIRE 305 makes a static measurement at 1 Hz. The
VWIRE 305 uses this measurement to get fine resolution in the dynamic-frequency
measurements. The static measurement also helps detect when a noise frequency that is near the
resonant frequency is affecting the dynamic measurement.

6.4 Embedded thermistor or RTD
Vibrating wire sensors often have an embedded thermistor or RTD that measures the temperature
of the sensor for compensation of thermal effects on the vibrating wire measurement. The VWIRE
305 measures this sensor at 1 Hz.

6.5 Rainflow histograms
Fatigue monitoring of large structures often uses rainflow histograms. The VWIRE 305 calculates
histograms using the rainflow algorithm developed by Matsuishi and Endo (1968).
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6.6 Diagnostics
The following diagnostic data are output with each dynamic measurement. You can use these
data to evaluate measurement quality:

l Excitation level
l Low-frequency and high-frequency warnings
l Low-amplitude and high-amplitude warnings
l Standard deviation

6.7 Data use
Campbell Scientific does not make recommendations about how to interpret or use vibrating
wire data, nor does it endorse the use of any specific manufacturer’s sensors. Examples given in
this manual are for educational purposes only. Consult competent and authoritative sources for
guidance in selecting sensors and interpreting vibrating wire data.

7. Specifications
All VWIRE 305 units meet electrical specifications in a standard temperature range of –40 to
70 °C, non-condensing environment. XD units are tested over an extended temperature range of
–55 to 85 °C. Recommended calibration interval is every three years.

7.1 Vibrating wire – specifications
VSPECT Technology Patents: U.S. Patent No. 7,779,690

U.S. Patent No. 8,671,758

Dynamic vibrating wire
measurement rate:

Accuracy:

Input resistance:

Excitation voltage

Range:

Resolution:

20, 50, 100, 200, or 333.3 Hz. Depends on resonant frequency 
of the gauges. See Table 9-1 (p. 22).
±(0.005 % of reading + effective measurement resolution)
5 kΩ

0 to ±3 V (6 V peak-to-peak)

26 mV
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Sensor resonant frequency
output range: See column three of Table 9-1 (p. 22).

Effective resolution 
(precision):  0.005 to 0.45 Hz RMS, depending on scan rate. See column five of

Table 9-1 (p. 22).

Sustained input voltage on
measurement terminal
without damage: –0.5 to 7.1 V

7.2 Temperature – specifications
Temperature measurement:  24-bit resistance measurement of thermistor or RTD embedded in

the vibrating wire sensor.

Rate: 1 Hz

Accuracy: 0.15 % of reading. Does not include cable resistance error, or
thermistor or RTD error.

Resolution: 0.002 Ω RMS @ 5 kΩ

Bridge resistor: 4.99 kΩ 0.1 %

Excitation voltage: 1.5 V

7.3 Module
7.3.1 Communications
CPI: RJ45 interface to Campbell Scientific data loggers, sensors, and

GRANITE Measurement Modules.

USB: USB micro-B device only, 2.0 full-speed 12 Mbps, for computer
connection.

7.3.2 System
Processor: Renesas RX63N (32-bit with hardware FPU, running at 96 MHz)

Memory: 2 MB SRAM
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7.3.3 Power requirements
Voltage: 10 to 32 VDC

Typical Current Drain: 190 mA@ 12 VDC

110 mA@24 VDC

7.3.4 Compliance
View EU Declarations of Conformity at www.campbellsci.eu/vwire305.

7.3.5 Physical attributes
Dimensions: 20.3 x 12.7 x 5.1 cm (8.0 x 5.0 x 2.0 in); additional clearance

required for cables and wires

Weight: <1 kg (2.0 lb)

Operating Temperature

Standard: –40 to 70 °C

Extended: –55 to 85 °C

8. Installation
Preconfigure and test stations in an indoor location before doing the field installation.

After installing a field station, wait around long enough to confirm that good measurements are
being made, that data are collected to the GRANITE data logger, and that data from the
GRANITE data loggercan be collected to a computer.

8.1 Install driver for computer connection 12

8.2 Operating systems 12

8.3 Configuring VWIRE 305 12

8.4 Data logger connection 14

8.5 Connecting multiple GRANITE Measurement Modules 14

8.6 Power connection 16

8.7 Earth ground connection 17

8.8 Mounting in an enclosure 17
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8.9 Field installation 18

8.1 Install driver for computer connection
Installing the VWIRE 305 may require a connection to a computer. Install the device driver before
plugging the VWIRE 305 into your computer for the first time. You will need the device driver
properly installed before you can connect to the VWIRE 305 via USB. SURVEYOR automatically
installs the required drivers. To install the device driver using the Device Configuration Utility,
select GRANITE > VWIRE 305. Click the Install the USB driver link and follow the prompts.

TIP:
Driver installation is optional for computers running Windows 10 and later.

8.2 Operating systems
Campbell Scientific posts OS updates at www.campbellsci.eu/downloads when they become 
available. Before deploying instruments, check operating system versions and update as needed 
to the most recent version. Use the Device Configuration Utility and follow the procedures on the 
Send OS tab.

NOTE:
For best performance, use the most recent operating system for each device.

8.3 Configuring VWIRE 305
The VWIRE 305 arrives ready to be connected to a system. Device configuration is only required
when multiple GRANITE Measurement Modules are connected to a single data logger. Each
module must have a unique address. Set a unique device name for further distinction between
GRANITE Measurement Modules.

Configure the VWIRE 305 using one of four methods: through DVWTool, the
CPIAddModule() program instruction, Device Configuration Utility software, or the CPIStatus
table.

8.3.1 Configuring using DVW Toolbox and LoggerNet
Modules are configured when connected to DVW Toolbox. DVW Toolbox sets the module CPI
address to 1 and sets up the measurement channels.

For more information see Quickstart (p. 2)
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8.3.2 Configuring with the CPIAddModule() instruction
To configure a VWIRE 305 within a program, use the CPIAddModule() instruction. A separate
instruction is used for each device. The CPIAddModule() instruction overrides settings
entered by other means, such as Device Configuration Utility or the CPIStatus table.

CPIAddModule(CDMType, CDMSerialNo, CDMDeviceName, CPIAddress)

The data logger creates an internal list of CPI modules from each CPIAddModule()
instruction. Modules added to the CPI bus will be checked against this list and reconfigured
accordingly.

NOTE:
The CPIAddModule() instruction overrides changes made through SURVEYOR, Device
Configuration Utility or the CPIStatus table.

8.3.3 Configuring with Device Configuration Utility
Install the device driver before connecting the VWIRE 305 to a computer. This is optional for
Windows 10, or later, operating systems.
1. Open Device Configuration Utility.

2. Under Device Type, select GRANITE > VWIRE 305.

3. Carefully review the Connect Instructions text provided on the right.
4. With the USB device driver installation complete, connect the supplied USB cable between 

the USB port on your computer and the USB port on the VWIRE 305.

5. Apply 9.6 to 32 VDC to the power terminals on the device.

6. Click the browse button next to Communication Port.

7. Select the port labelled VWIRE 305.

8. Click OK.

9. Click Connect then OK to avoid conflicts.

10. Set the Device Name (optional) and the CPI Address.

a. Device Name is a user-editable field to set a unique name to the VWIRE 305.
b. CPI Address specifies the address of the VWIRE 305. Each GRANITE Measurement 

Module connected to the same data logger must have a unique address. By default, 
the VWIRE 305 uses a CPI address of 1. Allowable addresses are 1 through 120.

11. Click Apply to save your changes.
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8.3.4 Configuring with CPIStatus table
When a GRANITE Measurement Module is used in a program, the data logger adds a CPIStatus
table to display current CPI information. View the CPIStatus table in the LoggerNet Connect
screen, or Device Configuration Utility Data Monitor tab. Information about each module
included in the data logger program or connected to the CPI bus appears in the CPIStatus table
within the ModuleInfo() array. Information is shown in the following order:

GRANITE Measurement Module Type, Serial Number, Device Name, CPI Address,
Activity

Within the ModuleInfo() array index string, the Device Name and CPI Address fields can be
edited. This provides a way to rename and readdress a VWIRE 305 through Campbell Scientific
software without editing the CRBasic program or connecting directly to the USB port.

See CPIStatus table (p. 46) for additional information.

8.4 Data logger connection
VWIRE 305 devices communicate with a data logger through a CPI port. Each VWIRE 305 ships
with a 6-inch RJ45 cable for this connection, though any CAT5e, or better, RJ45 cable can be
used. To allow daisy-chaining, two CPI ports are available on the VWIRE 305. Either can be used
for connection to a data logger.

The CPI port on VWIRE 305 connects directly to the CPI port on a GRANITE data logger module,
CR6 and the CR1000X.

8.5 Connecting multiple GRANITE
Measurement Modules
The CPI bus, which handles the communications between the data logger and GRANITE
Measurement Modules, can accept addresses 1 - 120. Multiple GRANITE Measurement Modules
may be connected to a single data logger using a daisy-chain or star topology. In both network
configurations, as total cable length increases, the maximum possible bit rate decreases.
Therefore, in networks with long cable lengths, it may be necessary to use the CPISpeed()
instruction to decrease the CPI network bit rate from its default 250 kbps. Limitations on cable
length and bit rate are discussed further in CPI network bit rate (p. 31) and listed in Table 9-4 (p.
31).
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8.5.1 Daisy-chain topology
In a daisy-chain topology, GRANITE Measurement Modules are connected one after another, as
shown in FIGURE 8-1 (p. 15).

FIGURE 8-1. Multiple GRANITE Measurement Modules connected in a daisy-chain
topology

For best performance, CPI terminators (supplied in GRANITE Network Kit) are usually installed in 
the open CPI ports at both ends of a daisy-chain network. But a half-terminated bus is also 
allowed by using only the resistors at the data logger end of the network. For more information 
see: https://s.campbellsci.eu/documents/eu/technical-papers/cpi-bus.pdf.

8.5.2 Star topology
A star topology uses a passive RJ45 hub, such as the HUB-CPI, to connect multiple GRANITE 
Measurement Modules. An illustration of this is shown in FIGURE 8-2 (p. 16).

NOTE:
Do not use a CPI-terminator with this configuration.
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FIGURE 8-2. Multiple GRANITE Measurement Modules connected in a star topology

8.6 Power connection
Connect the power supply to the removable Power connector on the side of the VWIRE 305.
Power supplies providing voltages from 9.6 to 32 VDC may be used.

l While the input power requirements of Campbell Scientific instruments vary, there is one
constant – they all run on 12 VDC. To keep things simple, we only discuss the use of 12 VDC
power supplies in this manual.

l Do not connect live leads to an instrument. All connections discussed assume dead leads,
so switch off power supplies before making connections.

l Double check the polarity of connections before switching on power supplies.

Open the power connector by inserting a screwdriver into the slots shown in FIGURE 8-3 (p. 16).
When the screwdriver is pushed in far enough, the orange terminals will open and remain open
until the screwdriver is removed. The power connector includes two positive (+VDC) terminals
and two negative (–VDC) terminals to allow for daisy-chaining power supplies. Terminals of the
same type open and close together. Insert the positive wire from the power supply into a +VDC
terminal, and insert the negative wire into a –VDC terminal.

FIGURE 8-3. Opening the power connector terminals
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8.6.1 Power-up sequence
Best practice is to power up all instruments in a station simultaneously from a single power
supply. If this is not possible, first power up VWIRE 305s, then power up the GRANITE data
logger. This procedure will reduce the time required to syncronize the CPI bus.

When the VWIRE 305 is powered up, the COMM Status light will flash yellow. Depending on the
state the VWIRE 305 was left in when last powered up, one or more of the Channel Status lights
may also flash.

See COMM status LED (p. 47) for more information.

8.7 Earth ground connection
Earth grounding provides protection from static discharge, transients, and power surges. A
ground lug is provided on the VWIRE 305 for connection to earth ground, see . Minimum 14
AWG ground wire is recommended. The earth side of the connection should be to a grounding
rod or other grounded device.

8.8 Mounting in an enclosure
GRANITE data loggers and measurement module brackets have mounting holes through which
small screws are inserted into nylon anchors in an enclosure backplate.

FIGURE 8-4. Enclosure backplate mounting

If mounting to a DIN rail, use the GRANITE-series DIN-Rail Kit as shown in the following images.
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FIGURE 8-5. GRANITE DIN-Rail Mounting Kit

FIGURE 8-6. DIN rail mounting

8.9 Field installation
This section discusses installation of a simple VWIRE 305 field station. Unlike the quickstart, a
field station includes a data logger to control and collect data from the VWIRE 305. Capacity of
the power supply is CRITICAL. VWIRE 305 field stations require continuous AC power or large
solar panels and batteries. See Power connection (p. 16). If switching back and forth between
DVW Toolbox and data logger control, cycle the power after each switch to let the VWIRE 305
adapt to the new connection.

8.9.1 Field installation equipment
l Vibrating wire sensor

l VWIRE 305 analyzer
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l GRANITE data logger

l Power supply

l Computer

l DVW Toolbox software

l LoggerNet software

l RJ45 cabling

l USB link with GRANITE data logger for initial setup. Other communications link may be
needed for long term monitoring.

FIGURE 8-7 (p. 19) provides a general schematic of a simple field station.

FIGURE 8-7. General schematic of simple field station

8.9.2 Field installation procedure
1. Do Quickstart (p. 2) and Programming quickstart using DVW Toolbox (p. 6).

2. Click Disconnect in DVW Toolbox. Switch off the power supply.

3. Connect the GRANITE data logger CPI port to the VWIRE 305CPI port using an RJ45
terminated CAT5e, or better, cable.

4. Place the CPI terminator (supplied in GRANITE Network Kit) in the remaining open CPI
port as shown below.
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FIGURE 8-8. CPI terminator placement

5. Interconnect ground lugs to an Earth ground. Use 14 AWG wire or larger. See Section 7.4.4,
Ground Connections (p. 23).

6. Connect the GRANITE to the power supply.

7. Switch on the power supply. During power up, lots of lights flash. After things settle down
(5 to 10 seconds), Channel Status lights should flash green (because you already performed
the bench test procedure). The COMM Status light should flash red.

8. Send the CRBasic program created with DVW Toolbox using the program Send command
in LoggerNet > Connect. When the program has compile, CPI network becomes active as
indicated by a flashing green COMMS Status light and flashing green and yellow lights on
the GRANITE CPI port.

9. In LoggerNet > Connect, monitor the system by viewing the variables: Freq, Diag,
StaticFreq, Therm, and DynStdDev.

For example, consider a station that includes a VWIRE 305 analyzer with a sensor
connected to input channel 1. In the Numeric Monitor, the data logger Public table will
look similar to the following figure:
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Only variables Freq(1), Diag(1), StaticFreq(1), Therm(1), DynStdDev(1) have data, indicating
channel 1 is active.

10. Collect and verify data in the other data tables before leaving the field.

9. Operation
9.1 VWIRE 305 sample rate 22

9.2 VWIRE 305 settings 22

9.3 VWIRE 305 outputs 27

9.4 Connections 30
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9.7 Data quality 35

9.8 Sensors 42

9.9 Status of input channels and sensors 45
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9.1 VWIRE 305 sample rate
The sample rate, the rate at which the VWIRE 305 measures the vibrating wire signal, is a key 
setting from which other VWIRE 305 settings and outputs are derived. The allowed sample rate is 
a function of the natural-resonant frequency of the sensor. For example, if a strain gauge is 
designed to operate with a frequency between 500 – 1200 Hz, do not sample it faster than 50 Hz.

The following table lists the five available sample rates and their specifications. This table is 
referenced throughout this manual.

Table 9-1: VWIRE 305 sample rates and specifications

Sample
rate1 (Hz)

Scan
interval
(mSec)

Sensor
resonance2

(Hz)

Sensor
resonance
range

boundary
resolution

(Hz)

Noise level3
(Hz RMS)

Maximum
supported
channels4

Maximum
VWIRE 305s

1 0.005

20 50 290 – 6000 47.68 0.008 64 8

50 20 290 – 6000 95.37 0.015 32 4

100 10 580 – 6000 190.73 0.035 24 3

200 5 1150 – 6000 381.47 0.11 24 3

333.3 3 2300 – 6000 762.94 0.45 16 2
1 Rates include the time needed to write data to a memory card. They do not include time needed to measure 
sensors outside the VWIRE 305 network. The fastest that a vibrating wire gauge can be measured is approximately 
20 percent of the resonant frequency.
2 Find the output range of a sensor in the documentation sent by the manufacturer.

3 Usual values for a 2500 Hz resonant sensor
4 Specifications are subject to installation factors such as CPI bus speed, CPI cable length, and unrelated demands 
on the data logger.

9.2 VWIRE 305 settings
Settings configure the VWIRE 305. Use DVW Toolbox software to edit and apply settings.
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NOTE:
The GRANITE data logger re-configures the VWIRE 305 when it is connected regardless of
what was done in DVW Toolbox. To get DVW Toolbox settings to persist do the
configuration in DVW Toolbox, then have DVW Toolbox write the data logger program
(CRBasic Code button), then load that program into the GRANITE data logger.

The following table summarizes VWIRE 305 settings and how to access them in DVW Toolbox
and CRBasic Editor.

Table 9-2: VWIRE 305 settings

Setting
(alphabetically) Definition

DVWTool
location,

options/range

CRBasic Editor
instruction,

parameter (arguments)

Channel
Enable

Activates a VWIRE 305
input channel

l Main window,
left

l Enable column
check box

l CDM_VW300Config()
l ChanEnable (0 or
1)

CPI Address Address of VWIRE 305
on the CPI network

l Main window,
lower left

l 1 to 120

l CDM_VW300Config()
l CPIAddress (1 to
120)

CPI Speed
Rate of CPI network
communications.
Default is usually OK.

l Main window,
lower center

l Auto-Detect, 50,
125, 250, 500,
1000 (kbps)

l CPISpeed()
l BitRate (50, 125,
250, 500, and
1000 kbps)

l Usually optional. Default
is 250 if CPISpeed()
not in program.

Device Name Optional VWIRE 305
alphanumeric name.

l Main window,
lower left

l Optional

l Visible in the CPI_Status
Table

Device Type Identifies the VWIRE
305to CRBasic.

l Main window
l Auto detected

l CDM_VW300Config()
l DeviceType
VWIRE305

DVW Toolbox
Update Rate

DVW Toolbox data
display rate. Default is
usually OK.

l Click View >
Advanced

l Main window,
lower right

n/a
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Table 9-2: VWIRE 305 settings

Setting
(alphabetically) Definition

DVWTool
location,

options/range

CRBasic Editor
instruction,

parameter (arguments)

High-
Frequency
Boundary

Upper boundary of
the operator-
determined range of
valid resonant
frequencies. See
Diagnostic codes (p.
36).

l Click Settings
l Range: 290 to
6000 Hz

l View/set in main
window

l CDM_VW300Config()
l HighFreq (290 to
6000 Hz)

Low-Frequency
Boundary

Lower boundary of
the operator-
determined range of
valid resonant
frequencies. See
Diagnostic codes (p.
36).

l Click Settings
l Range: 290 to
6000 Hz

l View/set in main
window

l CDM_VW300Config()
l LowFreq (290 to
6000 Hz)

Multiplier

Slope or gain applied
to the raw
measurement. See
Vibrating wire digits
conversion (p. 50),
and Calculating
vibrating wire
measurement error (p.
52).

l Click Settings
l Click View >
Frequency
Conversion to
view/set in main
window

l CDM_VW300Config()
l Mult

Offset

Offset or y-intercept
applied to the raw
measurement. See
Vibrating wire digits
conversion (p. 50),
and Calculating
vibrating wire
measurement error (p.
52).

l Click Settings
l Click View >
Frequency
Conversion to
view/set in main
window

l CDM_VW300Config()
l Offset
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Table 9-2: VWIRE 305 settings

Setting
(alphabetically) Definition

DVWTool
location,

options/range

CRBasic Editor
instruction,

parameter (arguments)

Output Format Sets the units for theoutput data.

l Click Settings
l Options: Hz, Hz2,
Digits, Scaled Hz,
or Scaled Hz2

l Click View >
Frequency
Conversion to
view/set in main
window

l CDM_VW300Config()
l ChanOptions (Hz,
Hz2)

Rainflow Form
Sets form of output
for a rainflow
histogram.

l Click Graph >
Rainflow
Histogram
Channel n

l Click lists then F1
for guidance.

l CDM_VW300Config()
l RF_Form

Rainflow High
Limit

High limit in a
rainflow histogram.

l Click Graph >
Rainflow
Histogram
Channel n

l Click field then
F1 for guidance.

l CDM_VW300Config()
l RF_HighLim

Rainflow Low
Limit

Low limit in a rainflow
histogram.

l Click Graph >
Rainflow
Histogram
Channel n

l Click field then
F1 for guidance.

l CDM_VW300Config()
l RF_LowLim
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Table 9-2: VWIRE 305 settings

Setting
(alphabetically) Definition

DVWTool
location,

options/range

CRBasic Editor
instruction,

parameter (arguments)

Rainflow
Minimum
Change

Minimum change in a
rainflow histogram.

l Click Graph >
Rainflow
Histogram
Channel n

l Click field then
F1 for guidance.

l CDM_VW300Config()
l RF_Hyst

Rainflow
Number of
Amp Bins

Number of amplitude
bins in a rainflow
histogram.

l Click Graph >
Rainflow
Histogram
Channel n

l Click field then
F1 for guidance.

l CDM_VW300Config()
l RF_MeanBins

Resonant
Amplitude

Amplitude target.
VWIRE 305
automatically adjusts
the vibrating wire
excitation to maintain
the target. Default (2
mV or 0.002 V) is
usually OK

l Click Settings
l Range: 1 to 10
mV

l View >
Advanced to
view/set

l CDM_VW300Config()
l ResonAmp (0.001
to 0.010 V)

Sample Rate

Rate at which the
VWIRE 305 samples
vibrating wire
resonant frequencies.
Sample rate
determines the range
of frequencies that
can be measured as
listed in the third
column of Table 9-1
(p. 22).

l Main window
upper left

l Options: 20, 50,
100, 200, 333.3
(Hz)

l Scan()
l Interval (50, 20,
10, 5, 3)

l Units (mSec)
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Table 9-2: VWIRE 305 settings

Setting
(alphabetically) Definition

DVWTool
location,

options/range

CRBasic Editor
instruction,

parameter (arguments)

Steinhart-Hart
Thermistor
Coefficient A,

B, C

Thermistor
coefficients. See
Measuring thermistors
and PRTs (p. 55)

l Click Settings
l View >
Temperature
Conversion to
view/set

l CDM_VW300Config()
l SteinA, SteinB,
SteinC

System options

Determines if a
numeric value or NAN
is stored in data
logger memory when
a warning flag is
raised, and whether or
not diagnostic lights
are active. See
CRBasic Editor Help
topic CDM_
VW300Config()
SysOptions and
Table 9-6 (p. 45).

n/a

l CDM_VW300Config()

l SysOptions (0, 1,
10, 11)

9.3 VWIRE 305 outputs
The following table summarizes VWIRE 305 outputs in DVW Toolbox and CRBasic Editor.
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Table 9-3: VWIRE 305 outputs

Output Definition
DVWTool
location,
options

CRBasic Editor
instruction,

output variable parameter

Actual
Low

Frequency

Low-frequency
boundary set by the
VWIRE 305 based on
the operator-entered
VWIRE 305 settings (p.
22) and the results of
measurements.

View > Advanced
then main screen n/a

Actual
High

Frequency

High-frequency
boundary set by the
VWIRE 305 based on
the operator-entered
VWIRE 305 settings (p.
22) and the results of
measurements.

View > Advanced
then main screen n/a

Diagnostic
Code

Diagnostic code
includes: • Excitation
strength

l Low-amplitude
flag

l High-amplitude
flag

l Low-frequency
flag

l High-frequency
flag

Click information
icon in Channel
column and warning
icon in column of
affected setting or

output.

l CDM_VW300Dynamic()
l DestDiag

Dynamic
Output

Dynamic resonant
output of the vibrating
wire sensor.

Main screen
l CDM_VW300Dynamic()
l DestFreq
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Table 9-3: VWIRE 305 outputs

Output Definition
DVWTool
location,
options

CRBasic Editor
instruction,

output variable parameter

Excitation
Strength

Voltage of the vibrating
wire excitation
expressed in bits 20 – 27
of the diagnostic code

View > Advanced
then main screen n/a

OS Date Date the operating
system was released Help > About n/a

OS
Version

Version of the VWIRE
305 operating system Help > About n/a

Serial
Number

Serial number of the
VWIRE 305

Main screen lower
center n/a

Std Dev of
Dyn Freq

Standard deviation of
the dynamic output
computed on one-
second data and output
at 1 Hz.

View > Advanced
then main screen

l CDM_VW300Static()
l DestStdDev

Static
Output

Static resonant output
of the vibrating wire
sensor.

Main screen
l CDM_VW300Static()
l DestFreq

Static
Thermistor

Temperature of the
thermistor or resistance
of the thermistor or RTD
that is embedded in the
vibrating wire sensor.
See Steinhart-Hart
Thermistor Coefficient
A, B, and C setting
VWIRE 305 settings (p.
22).

Main screen
l CDM_VW300Static()
l DestTherm
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9.4 Connections
9.4.1 Sensor connections 30

9.4.2 CPI network bit rate 31

9.4.1 Sensor connections
Vibrating wire sensors have either a three- or five-wire configuration. The five-wire configuration
includes a thermistor or RTD embedded in the body of the sensor. Refer to the sensor
documentation provided by the manufacture to confirm the function of each lead.

As shown in FIGURE 9-1 (p. 30), three-wire sensors have two leads that bridge the sensor coil to
the two VW terminals on the input channel. The VW terminals have no polarity. The third lead is
a cable shield that bridges the sensor ground to the ⏚ terminal.

FIGURE 9-1. Three-wire sensor connection schematic (no embedded temperature sensor)

Temperature changes in the body of a vibrating wire sensor can cause measurement errors. The
embedded thermistor or RTD in a five-wire sensor measures temperature change so that a
compensation algorithm can be applied to the output data.

As shown in FIGURE 9-2 (p. 31), five-wire sensors have two additional leads that bridge the
embedded thermistor or RTD to the two T terminals on the input channel. T terminals have no
polarity.
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FIGURE 9-2. Five-wire sensor connection schematic

9.4.2 CPI network bit rate
A CPI network is capable of operating at 1000, 500, 250, 125, or 50 kbps, depending on your
network configuration (see Connecting multiple GRANITE Measurement Modules (p. 14)). This is
the rate that data are transferred from the GRANITE Measurement Module to the data logger.
When multiple GRANITE Measurement Modules are making measurements faster than 1 Hz, it is
important to ensure that the CPI network bit rate is higher than the rate that data is generated by
the GRANITE Measurement Modules within the network.

To calculate how many kilobits per second (kbps) will be generated, use the following equation
for each GRANITE Measurement Module in your network:

Kilobits per second = (number of measurements) × (measurement frequency) × (0.064 kilobits
per measurement)

The network topology and cable length affect the maximum allowable CPI network bit rate. Refer
to Table 9-4 (p. 31) for the maximum cable length allowed for the topology and bit rate your
network requires. The bit rate of the network defaults to 250 kbps and can be changed by using
the CPISpeed() instruction in the data logger program.

Table 9-4: Network topology, bit rate, and cable length

Bit Rate1 (kbps)

Maximum total cable length (ft)

Daisy-chain topology Star topology

Full termination Half termination No termination

1000 50 1 not viable

500 200 200 100

250 500 400 400
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Table 9-4: Network topology, bit rate, and cable length

Bit Rate1 (kbps)

Maximum total cable length (ft)

Daisy-chain topology Star topology

Full termination Half termination No termination

125 1200 1000 1000

50 2800 2400 2400
1 Default Bit Rate is 250 kbps. Change with CPISpeed() instruction.

9.5 Analyzers and channel numbers
Up to eight analyzers can be connected to a GRANITE data logger through the CPI network.

NOTE:
Each analyzer requires the same system bandwidth whether or not all channels are active.

The sample rate determines the maximum number of vibrating wire sensors that can be
measured in a VWIRE 305 CPI network. See the seventh and eighth column in Table 9-1 (p. 22).

NOTE:
These channel counts do not account for other devices on the CPI bus or other measurement
or computation loads on the data logger.

9.6 Data logger program
The data logger controls and collects data from the VWIRE 305, and the CRBasic program 
controls the data logger. In most applications that use one analyzer, let DVW Toolbox generate 
the program. After setting up the VWIRE 305 and sensors, you generate the program by clicking 
the CRBasic Code button in the main DVW Toolbox window. Save the program to a file, or copy 
and paste the displayed code into another program using CRBasic Editor.

9.6.1 Program code
If you use more than one analyzer with a single data logger, or if you need a non-standard 
program, you can write a new program or edit an existing program using CRBasic Editor. See 
https://www.campbellsci.eu/downloads/cdmvw300-example-programs for example programs. 
Find the program that most closely fits your application and work from there.

FIGURE 9-3 (p. 33) shows essential instructions of the CRBasic program:
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FIGURE 9-3. CRBasic program basics

The following sections give short descriptions of VWIRE 305 related CRBasic instructions. CRBasic
Editor software Help has full descriptions of these instructions.

9.6.1.1 Pipeline mode
When controlling the VWIRE 305, the data logger automatically runs the CRBasic program in
pipeline mode to synchronize all measurement and control functions on the CPI network. You
can read more about pipeline mode in the data logger manual.

9.6.1.2 VWIRE 305 programming

CDM_VW300Config()
CDM_VW300Config() sends configuration settings to the VWIRE 305. Place it before the
BeginProg statement. It does not set the CPI address of the VWIRE 305. The CPI address must
be set with DVW Toolbox.

CDM_VW300Config(DeviceType, CPIAddress, SysOption, ChanEnable, ResonAmp,
LowFreq, HighFreq, ChanOptions, Mult, Offset, SteinA, SteinB, SteinC, RF_
MeanBins, RF_AmpBins, RF_LowLim, RF_HighLim, RF_Hyst, RF_Form)
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CDM_VW300Dynamic()
This instruction captures the dynamic output. Place it inside the main scan of the program.

CDM_VW300Dynamic(CPIAddress,DestFreq,DestDiag)

CDM_VW300Static()
This instruction captures static frequency, standard deviation of dynamic frequency at 1 Hz, and
temperature of the embedded thermistor or RTD. It is used in the main scan inside an If
TimeIntoInterval() conditional statement. Set TimeIntoInterval() to capture
static data at 1 Hz. You can capture static data less frequently, but only the latest sample will be
available.

If TimeIntoInterval(TintoInt, Interval, Units )
CDM_VW300Static(CPIAddress,DestFreq,DestTherm,DestStdDev)
...
EndIf

CDM_VW300RainFlow()
Place this instruction in a slow sequence to capture data for a rainflow histogram. See
SlowSequence instruction in CRBasic Editor software Help.

CDM_VW300RainFlow(CPIAddress, RF1, RF2, RF3, RF4, RF5, RF6, RF7, RF8)

RainFlowSample()
This instruction writes rainflow histogram data to a data table. The data table is usually set up to
store data once per minute. See DataTable instruction in CRBasic Editor software Help.

RainFlowSample(Source, DataType)

CPISpeed()
This instruction controls the speed of the CPI bus. This instruction is not normally needed. Use it
only when CPI bus communications need adjustment.

CPISpeed(BitRate)

CPIAddModule()
See Configuring with the CPIAddModule() instruction (p. 13).
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9.7 Data quality
The VWIRE 305 and DVW Toolbox have the following features to help you evaluate the quality of
vibrating wire data. For more discussion about some of these features, see VSPECT measurement
theory (p. 49).

9.7.1 Amplitude warning flags 35

9.7.2 Diagnostic codes 36

9.7.3 DVW Toolbox errors 37

9.7.4 Excitation strength 38

9.7.5 Frequency filters 38

9.7.6 Frequency warning flags 41

9.7.7 Sample rate and noise performance 41

9.7.8 Standard deviation 41

9.7.1 Amplitude warning flags
An accurate measurement requires the resonant amplitude of the sensor to be greater than 50 %
and less than 200 % of the Resonant Amplitude setting. If the resonant amplitude is less than 50
% of the resonant amplitude setting, a low-amplitude warning flag is triggered. Greater than 200
% triggers a high-amplitude warning flag. Most sensors respond well to the default amplitude
setting. Weak sensors will require a stronger excitation pulse to achieve the amplitude setting
target value. Raising the amplitude setting gives a larger signal-to-noise ratio but subjects the
sensor to stronger excitation energy.

When the frequency of a sensor changes fast, the measured phenomenon is probably changing
fast. When this happens, energy in the vibrating wire may drop briefly until the excitation
mechanism can insert energy at the new frequency. A low-amplitude warning flag may occur
briefly; this is usually OK.

If a warning flag is present for a long time, check the source of the error as follows:

l Check the sensor connection.
l Check that the sensor is outputting correct data.
l Fine tune the VWIRE 305 scan rate. See Sample Rate in Table 9-2 (p. 23).
l Check that the frequency being output by the sensor is within one of the frequency output
ranges supported by the VWIRE 305. See the first and third columns in Table 9-1 (p. 22).
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9.7.2 Diagnostic codes
The VWIRE 305 outputs binary diagnostic codes with each measurement at the VWIRE 305
sample rate. These codes include information about excitation strength, frequency warning flags,
and amplitude warning flags.

When using a data logger with the VWIRE 305, write program code to interpret the diagnostic
codes. An alternative is to save diagnostic codes with the measurement data and interpret the
codes with post processing.

Each diagnostic code is a 32 bit unsigned integer encoded with the following diagnostic
parameters.

l Excitation strength
l Low-amplitude warning flag
l High-amplitude warning flag
l Low-frequency warning flag
l High-frequency warning flag

When there are no warning flags, the diagnostic code is between 0 and 255 and indicates only
excitation strength. When there are warning flags the diagnostic code is greater than 255 and is
the sum of the excitation strength and the flag value. The following table summarizes diagnostic
codes that indicate warning flags:

Table 9-5: Diagnostic code ranges

Diagnostic code
range1

Excitation
only

Low-
amplitude
warning

flag present2

High-
amplitude
warning

flag present2

Low-
frequency
warning

flag present2

High-
frequency
warning

flag present2

0 – 255 ü

256 – 511 ü

512 – 767 ü

768 – 1023

1024 – 1279 ü

1280 – 1535 ü ü

1536 – 1791 ü ü

1792 – 2047

2048 – 2303 ü
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Table 9-5: Diagnostic code ranges

Diagnostic code
range1

Excitation
only

Low-
amplitude
warning

flag present2

High-
amplitude
warning

flag present2

Low-
frequency
warning

flag present2

High-
frequency
warning

flag present2

2304 – 2559 ü ü

2560 – 2815 ü ü

1 Diagnostic codes outside these rangesmay occur when hardware, firmware, or CRBasic programming errors
occur.
2 Amplitude warning flags and frequency warning flags have the following restrictions:

l Ameasurement can have a low-amplitude warning flag or high-amplitude warning flag, but not both.

l Ameasurement can have a low-frequency warning flag or a high-frequency warning flag, but not both.

l Ameasurement can have both an amplitude warning flag and a frequency warning flag.

9.7.3 DVW Toolbox errors
As shown in FIGURE 9-4 (p. 38), DVW Toolbox Error Indicators, DVW Toolbox indicates
measurement errors in the following ways:

l Information icon ( ) in the Channels and a warning icon ( ) in the affected field. Click
on an icons for more information.

l Red or flashing-red measurement values
l A warning icon ( ) if the Resonant Amplitude (0.1 to 10 mV) or the frequency boundary
settings are out of range. Click on the icon for more information.
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FIGURE 9-4. DVW Toolbox error indicators

9.7.4 Excitation strength
Excitation strength is output with each dynamic measurement as part of the diagnostic code. See
Diagnostic codes (p. 36). If it changes significantly, spend time to figure out what is causing the
change. Significance of change depends on the application, but a sudden or large permanent
change from a baseline (be sure to determine and record a baseline when first installing a
station) indicates there is likely a problem with the sensor.

An increase in excitation strength usually means the sensor is less responsive, so it must be driven
harder to get the same response. Some sensors become less responsive with age.

A change in the phenomenon being measured usually has a negligible effect on the excitation
strength. One exception is if the phenomenon being measured changes its frequency band of
variation. For example, consider a sensor measuring strain on a structure. It measures an
oscillation in the range of 1 to 2 Hz, which is the natural harmonic frequency of the structure.
Then a change is made to the structure to stiffen it so that the natural frequency is now 10 to 20
Hz. When this happens, more energy is dissipated in the sensor as variations occur faster. So,
even though the mean value of the strain in the sensor did not change, more energy (higher
excitation strength) is required to produce the signal.

9.7.5 Frequency filters
9.7.5.1 Harmonics 39
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9.7.5.2 Estimated frequency range 39

9.7.5.3 Actual frequency range 39

9.7.5.1 Harmonics
Some sensors have very strong harmonics that can exceed the amplitude of the fundamental
resonant frequency; this results in measurement error. You can eliminate harmonics by adjusting
the frequency boundaries. By putting the harmonic outside the range of allowed frequencies, it is
eliminated as a source of error. Also, spurious noise sources can be excluded from the
measurement range by selecting appropriate range boundaries.

If adjusting frequency boundaries does not reduce error, force the VWIRE 305 to re-assess the
primary frequency by either disabling then re-enabling the input channel or by resending the
CRBasic program to the data logger.

9.7.5.2 Estimated frequency range
The VWIRE 305 filters unwanted frequencies, such as harmonics, from vibrating wire output using
the operator-entered low-frequency boundary and high-frequency boundary. The range
bounded by these estimates is the estimated-frequency range. Enter boundary estimates into
DVW Toolbox low-frequency boundary and high-frequency boundary columns or CRBasic CDM_
VW300() instruction LowFreq and HighFreq parameters. The best source for boundary
estimates is the sensor manufacturer — perhaps in a calibration report.

9.7.5.3 Actual frequency range
Due to the mathematical constraints of the algorithms, the VWIRE 305 cannot usually comply
with the exact boundary values specified by the user. It establishes the actual-frequency range,
which is bounded by the actual-low frequency and actual-high frequency. Boundary values are
excluded from the frequency ranges.

FIGURE 9-5 (p. 40) shows how boundaries and ranges relate to each other:
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FIGURE 9-5. Relationship of estimated- and actual-frequency ranges and frequency
warning flags

The actual range is equal in size or larger than the estimated range. If you wish to know the
actual boundaries, in DVW Toolbox, click on View > Advanced. Two new columns, Actual Low
Frequency and Actual High Frequency, appear on the main window.

If using DVW Toolbox is not practical, you can calculate the actual boundaries. Calculate the
actual-frequency range using boundary resolution value in the fourth column of Table 9-1 (p. 22)
as a reference. For example, if the data logger scan interval is set to 500 ms, the VWIRE 305
sample rate is 20 Hz and its boundary resolution is 47.68 Hz. If you estimate the low-frequency
boundary at 150 Hz, the nearest multiple of 47.68 Hz that is less than the estimate is 143.04 Hz (3
• 47.68 Hz). Enter 143.04 into low-frequency boundary in DVW Toolbox or LowFreq in CRBasic.
Likewise, if you estimate the high-frequency boundary at 500 Hz, the nearest multiple of 47.68
Hz that is more than the estimate is 476.80 (10 • 47.68 Hz). Enter 476.80 into high-frequency
boundary in DVW Toolbox or LowFreq in the CRBasic program.

Matching estimated and actual frequency ranges
Minimize the difference between the estimated-frequency range and the actual-frequency range
by entering the actual frequency values as the low-frequency boundary and high-frequency
boundary. However, there are benefits to not having the estimated-frequency range match the
actual-frequency range. The VWIRE 305 issues warning flags if the measured frequency falls in
the gaps between the two ranges.
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9.7.6 Frequency warning flags
Frequency warning flags are triggered at the following times:

l When a resonant frequency falls between the estimated- and actual-frequency ranges. This
may indicate a change in the output of a sensor before the output moves outside the
actual-frequency range. See FIGURE 9-5 (p. 40).

l When the low-frequency boundary or high-frequency boundary is set outside the range
allowed by the selected sample rate.

l When the Sample Rate setting is invalid for the resonant frequency. See Table 9-2 (p. 23).

For example, at the VWIRE 305 sample rate of 100 Hz, the VWIRE 305 can measure frequencies
anywhere from 580 to 6000 Hz. A resonant frequency outside this range will trigger a flag.
Furthering this example, if signal frequencies output by the sensor always fall between 2000 and
3000 Hz, you can set the low-frequency boundary to 2000 Hz and the high-frequency boundary
to 3000 Hz. The VWIRE 305 will adjust the boundaries to 1907.3 Hz and 3051.68. If a measurement
falls between 1907.3 and 2000, a low-frequency warning flag is raised. If a measurement falls
between 3000 and 3051.68, a high frequency warning flag is raised.

See Diagnostic codes (p. 36) for further discussion of warning flags and how they are tagged to a
measurement.

9.7.7 Sample rate and noise performance
Electrical noise limits the effective resolution, or precision, of a vibrating wire measurement. To
increase precision, decrease the measurement sample rate. The fifth column of Table 9-1 (p. 22)
lists the noise level associated with each sample rate.

Other topics that discuss noise performance are found in the following sections:

l Static measurement (p. 8)
l Frequency filters (p. 38)
l VSPECT measurement theory (p. 49)
l Calculating vibrating wire measurement error (p. 52)

9.7.8 Standard deviation
The CDM_VW300Static() instruction has an option to output a 1 Hz calculation of the
standard deviation of the dynamic readings. If the standard deviation changes significantly,
spend time to figure out what is causing the change. Significance of change depends on the
application. For example, a significant increase from a baseline (be sure to determine and record
a baseline when first installing a station) may indicate a problem with the sensor or a significant
shift in the structure or phenomenon being measured.
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9.8 Sensors
Vibrating wire sensors come in many varieties for many applications, but they all have the same
basic design features and fundamentals of operation. When choosing a sensor, beside the form
and fit, the basic fundamentals of operation affect how well your sensor performs with the
VWIRE 305.

9.8.1 Sensor basic design features
Vibrating wire sensors have the following components, which are illustrated in FIGURE 9-6 (p.
42):

l Sensing element
l Taut wire attached to sensing element
l Plucking and pickup coils
l Optional thermistor or RTD
l Two coil input/outputs
l Two thermistor input/outputs

FIGURE 9-6. Basic design features of a vibrating wire sensor

9.8.2 Basic measurement of the sensor
The VWIRE 305 applies excitation and measures the return vibrating wire signal on the plucking
and pickup coil leads. It applies excitation and measures the return temperature signal on the
thermistor leads.

9.8.3 Vibrating wire length and tension
Vibrating wire sensors vibrate within a discrete frequency-output range that is determined by the
manufacturer. The frequency of the vibration is a function of two factors: the length of the wire
and the tension of the wire.
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Length is fixed because that is how the sensor is built. Tension, however, changes as the 
environment around the sensor changes. For example, the wire in a pressure sensor is attached at 
one end to a diaphragm. As the diaphragm flexes with changes in external pressure, the wire is 
stretched or relaxed. The stretch or relaxation is proportional to external pressure.

Depending on the purpose of the sensor, the manufactured lengths of vibrating wires vary 
widely. Shorter wires vibrate at higher frequencies, longer wires at lower frequencies. For 
example, one to two inchgages vibrate near 3000 Hz, while six inch gauges vibrate near 900 Hz.

9.8.4 Sensor output frequency range and maximum
sample rate
Higher VWIRE 305 sampling rates require higher and tighter sensor frequency-output ranges. 
The vibrating wire in a sensor must vibrate five to 10 times per measurement for the VWIRE 305 
to pick it up. Longer gauges, such as those that vibrate near 900 Hz, cannot be measured at 
higher VWIRE 305 scan rates because the wire does not vibrate fast enough to get the required 
number of vibrations for a measurement.

As a general rule, the fastest that a vibrating wire gauge can be measured is approximately 20 
percent of the resonant frequency. For example, a gauge that resonates at about 1100 Hz can be 
measured at a maximum of 20 % of 1100 Hz, or at 220 Hz, so the 200 Hz measurement range is 
used.

The third column of Table 9-1 (p. 22) lists the sensor frequency-output ranges that can be 
measured at the VWIRE 305 sample rates.

Some applications may require that a sensor be used that can be sampled over a wide range of 
sample rates. Sensors with higher resonant frequencies are more versatile. For example, as shown 
in the previous table, a sensor with a resonant frequency of 2000 Hz can be measured at scan 
rates 20, 50, 100, 200, and 333.3 Hz. On the other hand, a sensor with a resonant frequency of 290 
Hz can be measured only at 20 or 50 Hz.

9.8.5 Temperature sensor
FIGURE 9-6 (p. 42) shows the location of the temperature sensor. Sensor manufacturers have 
many thermistors and RTDs to choose from, so this manual has only general guidelines about 
measuring an embedded temperature sensor. Additional information is in Measuring thermistors 
and PRTs (p. 55).

Be aware that some manufacturers, Slope Indicator, for example, use different thermistors or 
RTDs in the same model of sensor according to what the client orders. Take this into 
consideration when specifying and ordering sensors.
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Procedure:

1. Do the procedure in Quickstart (p. 2).

2. If there are values other than zero in the DVW Toolbox Steinhart-Hart Coefficients A, B,
and C columns for the sensor, write these down because you may need them later.

3. Set Steinhart-Hart Coefficients A, B, and C to 0.

4. Connect one lead from the temperature sensing element (it does not matter which one) to
either of the T terminals of the same input channel to which you connected the vibrating
wire sensor. Connect the other lead to the other T terminal. You should immediately see a
resistance value in the Static Thermistor column of DVW Toolbox. This is the resistance
value of the temperature sensing element. It is expressed in ohms (Ω). Check this resistance
against the documentation that came with your sensor to confirm that the correct
resistance is displayed for the current temperature.

5. Convert the measured resistance to temperature:

l If the temperature sensing element is a thermistor, do the following:
o Enter the Steinhart-Hart coefficients provided by the manufacturer into the
Steinhart-Hart Coefficients A, B, and C columns. The value in the Static
Thermistor column should now be the current temperature expressed in
degrees Celsius. For DGSI sensors, our C coefficient equals their D coefficient.

o Set up the VWIRE 305 to convert the resistance to temperature by entering the
Steinhart-Hart coefficients into VWIRE 305 settings using DVW Toolbox,
Device Configuration Utility, or a program created with CRBasic Editor.

l If the element is an RTD, do the following:
o Some sensors use PRTs instead of thermistors. If your sensor is a PRT, find the
Calendar-Van Dusen coefficients on the manufacturers calibration sheet.

o Add code to the program created with CRBasic Editor to convert resistance to
temperature. The PT100 PRT discussion in Campbell Scientific data logger
manuals may help you do this.

l The other option for both thermistors and PRTs is to simply store the resistance data
then convert resistance to temperature on a computer after collecting data from the
field.

TIP:
It is good practice to preserve the original vibrating wire measurements when converting
them to temperature compensated values.
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Convert the original vibrating wire measurements to temperature compensated measurements by
adding code to the data logger program, or by calculating the compensation on a computer
after data are collected from the field. For either option, you need to get the compensation
equation and factors from the sensor manufacturer. These may be on the calibration sheet.

9.9 Status of input channels and sensors
The status of VWIRE 305 input channels and the sensors connected to them can be determined
by interpreting the state of the Channel Status lights. The following table summarizes the
interpretation of these states.

Table 9-6: Channel Status lights

Light state Channel status

Flashing red or green at 3 s interval Channel enabled

Flashing green Channel enabled; sensor active; measurements
within set ranges

Flashing red
Channel is enabled; sensor is active; some
measurements are outside set range(s), so

diagnostic warning flag(s) is True.

Dark; not flashing Channel disabled

10. Troubleshooting
1. Check the voltage of the power source at the Power connector. It should be between 9.6
and 32 VDC.

2. Check wires and cables for the following:

l Loose connection points

l Faulty connectors

l Cut wires

l Damaged insulation, which allows water to migrate into the cable. Water, whether or
not it comes in contact with wire, can cause system failure. Water may increase the
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dielectric constant of the cable sufficiently to impede sensor signals, or it may
migrate into the sensor, which will damage sensor electronics.

3. Check the CRBasic program. Create a simplified version of the program, or break it up into
multiple smaller units to test individually. For example, if a sensor signal-to-data
conversion is faulty, create a program that only measures that sensor and stores the data,
absent from all other inputs and data. Write these mini-programs before going to the field,
if possible.

4. Verify that each VWIRE 305 in the network has a unique CPI address.

5. Check the data logger and VWIRE 305 operating system and update them as needed.

6. Check that the scan rate is long enough for the measurement time. The data logger
compiler often catches scan rates that are too fast.

7. Ensure that the CPI network bit rate is fast enough for the data generated and that it can
accommodate the cable lengths in use. (See CPI network bit rate (p. 31).)

10.1 CPIStatus table
Information in the CPIStatus table, located in the data logger, helps in troubleshooting. The
ModuleInfo() array shows the following information:

CDM Type, Serial Number, Device Name, CPI Address, Activity

The last entry in the ModuleInfo() index shows the activity of the module. Possible entries and
their meanings are shown in the following table.

Table 10-1: CPIStatus activity

Response Meaning

Active The module is connected to the CPI bus and is making measurements according to
the data logger program.

Offline The module was present after startup but is no longer responding.

Unused The module is or was connected and powered but is not included in the data
logger program.

Wait Config The module has not yet responded to a data logger’s attempts to configure it.

Config Fail The module could not be configured. A configuration error message is appended
to this response.
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10.2 COMM status LED
The COMM status LED indicates the current operation of the VWIRE 305, as shown in the
following table..

Table 10-2: COMM Status LED Activity

Green Flashing Module has been configured by data logger and is receiving sync
signals

Regular red/green
cycle Flashing Too many channels or analyzers for the configuration.

Green and Red Flashing CPI network initializing.

Red Flashing Power lost to CPI network but VWIRE 305 is still powered or CPI
speed mismatch.

Yellow Flashing VWIRE 305 powered but not connected to CPI network.

10.3 CPI port LEDs
Green and Orange LEDs on the CPI bus indicate the current operation of the CPI bus as shown in
the following table.

Table 10-3: CPI port LED activity

Green Flashing Frame sync

Orange
Flash CPI activity

Solid CPI bus fault

10.4 Replacing a GRANITE measurement
module
An existing VWIRE 305 can be replaced with a new module using the same CPI address without
requiring a change to the program.
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Appendix A. VSPECT
measurement theory
In a vibrating wire sensor, the coil serves the following functions:

l Actuator to put energy into the wire
l Pickup to detect the motion of the wire

The resonant frequency of a vibrating wire cannot be measured at static rates faster than about 1
Hz. A static measurement excites the wire and measures the response. Excitation is a swept
frequency sine wave that supplies a broad spectrum of frequencies to the wire. If you listen
closely to most vibrating wire sensors, during a static measurement you can hear tones ascending
through the swept frequency excitation. Time is then required for the non-resonant frequencies
to die out, and then more time is needed to sample the resonant frequency. Additional time is
required for the resonant frequency to die out before the next excitation/measurement cycle
begins.

In contrast, the VWIRE 305 makes dynamic measurements at rates as high as 333.3 Hz. The key
difference in the dynamic method versus the static method is that the wire is maintained in a
continuously vibrating state. The dynamic process eliminates the swept frequency sine wave.
Instead, the VWIRE 305 injects energy into the oscillation at just the right frequency and phase,
so a very short excitation with small amplitude maintains wire resonance. Phase alignment of
excitation strengthens wire resonance and decreases measurement noise.

The system synchronizes all measurement channels to the data logger clock through the CRBasic
program and CPI bus. Synchronization has the added benefit of allowing for simultaneous
sampling of channels, so there is good measurement correlation across multiple sensors and
multiple modules. Synchronized excitation is a key difference between dynamic VSPECTTM
measurements and other auto-resonant excitation schemes.

To improve dynamic measurements, the VWIRE 305 measures a static frequency at 1 Hz and uses
it as a reference in noise rejection. Since the VWIRE 305 samples only a few cycles of the wire
each time it makes a dynamic measurement, the spectral resolution is coarser than when using all
captured data. As a result, occasional noise frequencies are gathered into the same FFT (Fast
Fourier Transform) bin as those of the signal, which causes measurement error. The VWIRE 305
measures the static frequency at a finer resolution to detect the noise and prompt you to take
corrective action.
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Appendix B. Vibrating wire
digits conversion
Manufacturers usually include calibration data with vibrating wire sensors. Use the data to 
convert frequency to a unit of measure.

The VWIRE 305 is usually set up to measure frequency in units of Hertz (Hz), but some calibration 
sheets report data in units of digits or B units. If this is the case with your sensor, convert Hertz to 
digits with the following formula:

digits or B units = Hz2 / 1000
Use the gauge factor and polynomial from the manufacturer's calibration sheet to convert to 
units of measure.

Using the calibration report shown in FIGURE B-1 (p. 51), the following example converts 
frequency to displacement:

For example, the VWIRE 305 measures a displacement sensor and reports a frequency of 2400 Hz. 
The relationship of sensor output to displacement, s, is expressed in the calibration report as 
follows:

s = (9.139E–08) × digits2 + (0.03054) × digits + (–80.471)

The conversion procedure follows:

1. Convert hertz to digits:

digits = (2400 Hz)2 / 1000 = 5760

2. Convert digits to displacement:

s = (9.139E–08) × (5760)2 + (0.03054) × 5760 + (–80.471)

s = 98.47 mm
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FIGURE B-1. Geokon calibration report
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Appendix C. Calculating
vibrating wire measurement
error
The fundamental measurement of the VWIRE 305 is frequency, f.

Wire tension is the square of the resonant frequency (f2). The calibration report from the sensor
manufacturer provides a formula for converting frequency, f, to the target unit of measure, UE, as
follows:

UE = Kf2 Eq. 1

K is the calibration constant.

For a very small change in frequency, ∆f, change in UE, ∆UE, is expressed as follows:

∆UE = 2Kf∆f Eq. 2

Eq. 2 (p. 52) is the first derivative of Eq. 1 (p. 52) with respect to f.

Effective resolution of a measurement, Re, is calculated using Eq. 2 (p. 52) and a noise level, N.
Values for N are found in the fifth column of VWIRE 305 sample rates and specifications (p. 22).
For a specific VWIRE 305 scan rate, use the corresponding N value in place of ∆f. Eq. 2 (p. 52) is
then expressed as follows:

Re = 2KfN Eq. 3

C.1 Error example: Geokon strain gauge
K is calculated as follows:

K = GB / 1000
G is gauge factor 4.062 or 0.391, depending on gauge type. B is the batch factor, which is usually 
a number within a few hundredths of 1. These values are found on documentation provided by 
the sensor manufacturer.

Microstrain:

µε = GBf2 / 1000
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Effective resolution, (Re):

Re = ∆µε

∆µε = 2GBfN / 1000

∆µε = GBfN / 500
N is the noise level given in VWIRE 305 sample rates and specifications (p. 22) corresponding to 
the VWIRE 305 scan rate being used.

C.2 Error example: DGSI embedment strain
gauge
K = G

G = 4.0624E–03

Microstrain:

µε = Gf2

Effective resolution, (Re):

Re = ∆µε

∆µε = 2GfN

C.3 Error example: DGSI spot-welded strain
gauge
Microstrain:

µε = Af2 + C
A = 7.576E–04 and C = –2030.1
So, K = A.
For effective resolution, C does not vary with frequency, so it can be ignored for very small 
changes in frequency.

Effective resolution, (Re):

Re = ∆µε

∆µε = 2AfN
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C.4 Error example: Geokon 4420 crack
meter
Displacement (s):

s = (Gf2 / 1000) + Kt
G = linear gauge factor
K= thermal factor
t= temperature of the sensor
During a short measurement interval, assume no change in sensor temperature. So, for small 
changes in sensor displacement, K is assumed to be constant, and the Kt term is ignored when 
calculating the output error:

∆s = 2GfN / 1000

∆s = GfN / 500

C.5 Error example: DGSI piezometer
52611099
Pressure:

P = Af2 + Bf + C
A, B, and C are gauge factors.

Effective resolution:

Re = ∆P

∆P = (2Af + B)N

∆P = 2AfN + BN
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Appendix D. Measuring
thermistors and PRTs
Vibrating wire sensors may include an embedded thermistor or PRT (platinum resistance
thermometer).

D.1 Converting PRT resistance to
temperature
The VWIRE 305 analyzer does not support direct PRT measurement conversion to temperature,
but it does measure PRT resistance. You can add lines of code to the CRBasic data logger
program to convert PRT resistance to temperature, or you can convert the resistance as part of a
post-processing operation in a spread sheet or other software. You will need to get PRT
conversion factors from the sensor manufacturer.

D.2 Converting thermistor resistance to
temperature
Convert resistance of most thermistors using the Steinhart-Hart equation as follows:

°C = 1 / (A+B(ln(R)) + C(ln(R))3) – 273.15

Where ln(R) is the natural log of the resistance measurement and A, B, and C are Steinhart-Hart
equation coefficients. Each thermistor type has unique coefficients. Sensor manufacturers
provide the coefficients. Our C coefficient is DGSI’s D coefficient.

Example:

The Steinhart-Hart coefficients for the thermistor embedded in a standard Geokon vibrating wire
sensor are as follows:

A = 1.4051E–03

B = 2.369E–04

C = 1.019E–07

The Steinhart-Hart equation to convert thermistor resistance to degrees Celsius is as follows:

°C = 1/ (1.4051E–03 + 2.369E–04(ln(R)) + 1.019E–07(ln(R))3) – 273.15
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If R is 2221 Ω, temperature is calculated as follows:

°C = 1/ (1.4051E–03 + 2.369E–04(ln(2221)) + 1.019E–07(ln(2221))3) – 273.15

°C = 31.98

D.2.1 Thermistor measurement accuracy and resolution
Accuracy of a thermistor temperature measurement is a function of the following factors listed in
order of importance:

1. Thermistor interchangeability

2. Change in cable resistance

3. Cable resistance

4. Steinhart-Hart equation error

5. Precision of the bridge resistors

6. Accuracy of the data logger voltage measurement

7. Temperature coefficient of the bridge resistors

Factor 1, interchangeability, expresses how tightly sensing elements of the same type conform to
the ideal. Deviations from the ideal are caused by slight manufacturing differences. Thermistor
manufacturers do not calibrate each thermistor produced. Instead, each thermistor is
manufactured to meet the ideal within certain tolerances. For example, the Measurement
Specialties 100K6A1iA thermistor is manufactured to be within ± 0.10 °C of the ideal at 0 to 50 °C.
So, one 100K6A1iA thermistor can be interchanged with another. Each thermistor will measure
within ± 0.10 °C of the ideal.

Factor 2 is primarily caused by changes in cable temperature. Increase in temperature causes an
increase in cable resistance. Increase in cable resistance passes into the measurement as an
increase in thermistor or PRT resistance. FIGURE D-1 (p. 57) shows how wire resistance affects the
temperature measurement for a Geokon 4500 vibrating wire piezometer. The vibrating wire
measurement is not affected significantly by cable temperature, but the temperature
measurement is affected slightly.

If the vibrating wire measurement is temperature corrected, then Factor 2 does affect the
vibrating wire measurement. For this reason, in applications where temperature measurement
errors must be minimized, the sensor cable should be shielded from the sun and other sources of
significant thermal potential, hot or cold.
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FIGURE D-1. Temperature-induced measurement error on a 1000 foot lead. Wire is 22
AWG, 16 Ω per 1000 feet.

Factor 3, cable resistance, is primarily an offset error and is usually removed by the
manufacturer's initial calibration. FIGURE D-2 (p. 57) emphasizes the importance of removing
offset by showing how offsets due to cable length influence measurement error. Offset correction
is valid if cable length and type are not altered from that received from the manufacturer.

FIGURE D-2. Temperature error offsets at three temperatures as a function of lead
length. Wire is 22 AWG, 16 Ω per 1000 feet.

Factors 4 through 7 are usually very small and ignored.
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